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WA T AT K, XA IR Design Patterns: Elements of Reusable Object-
Oriented Software (I . A& HTH M X R KA TCE) L i 4 A3 RITE S M (R £
A% B 422 GoF 483X 4 fi/E# , GoF M )& Gangs of Four, BIU AH) ,

BB AUHE AR A B AT R bz I BB, BB AR 2 R0 5
PSR T O B AW s 2. (B2, 53] GoF By 45 ok Z iy, IfF A —Fh
e — iR BUE UG IS I XA I B AT T i — S AR & L 3k B Ty vk AR A AR 7 25 56 B B O I
ARG R B IE i — R e

T B UHS R GE Ay 44 SRR FN DR 1T () X R R G D — A R A B
Bt A B R X SE B AR S, it T LA 58 4l AR R E L WSR2 2 5 A A 5
PR SR, XX R R RS A E 5 ER T M. AR, X SR T LR
Fe FHORA T 10 10 X 5 2R 46 2 00 5 B X 2 A
()R, G0 SR AT A ) 0 ) 880 55, B4 sk S 5
AL T XAl L ER L T ARG,

MVC R E — AR # WA B, BT i
MVC #5 50, BF A5 B4 15145 i %% (Model-View-
Controllen) X, MVC 22K W&l 5-1 B/ E 51 MVC 345

1. Model 3

TE MVC Hr A5 R 2 AT J7E AT 55 B9 AR A5, 1 3 350 40 A% 65 I 3 A5 AT {a) 32 4 e g FH s
BN, Model R 4TI RE B 1, ik J& — RV WY 2 Fe 5 v, i oo ix s 4t
5L AT LA BOSAR BRY s 19 BT B RE

2. View i

£ MVC R B, — 4~ Model 7] LA JLA View ¥, 1M 3£ br b Z2 A4 View Ui & # H
MVC WFEIEBIHL, fHH MVC BT D ARiF 2 T —A 1 View Wi £ 78 I 7T LUAE 75 22 09 B
N T FEM T EN View,

3. Controller ¥

MV C B2 A 0 5 MVC B8l 2 45 A 00 F B9 . 24 11 o 5 A0 o7 10 90 P & A 58
LIS P AT L g A T T R AR 14 RS T K e R A A e e AT R
3 3 A AR AR o 1) % OO A . 5 TR B s o i 2 8 90 T A T T R L B
FH P S .

BB 2 AdH] MVC B2 A BRLE A S W2 MVC il ad LLF 3 By 2008 5 5 1 5 38 100 fim
I %t G2 R TR T 6 14 44 ¥ 4 TR U

(1) 4 il 1 38 2k — AN PR A5 AL BR 5 R0 Ach B 7 ) 4584 %) FH P R . 3 PR 0/ 9 o 9 AR A0 B
B S N R ok RS R (Y X G, O LR T [ B VR (0 4 F 2 A 5 T 1) X R BT R, X
A B ES A Bh T B Lk 1 1 % 5 A0 8 1A i

(2) MVC B F P 42 11 518 ) %k G2 80 43 JF . 3% Ao 3/ [R) R 9 A5E 28 AN R A el st T file
2 R R A s I 2. BRI 22 A, SR ASE 78 T vy 4 o 2 57 0, 0 4 B T ek T LA
g FH P
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(3) MVC FuiF R 4 FH P 3 100 AT R B A2 AR T A 52 R B . 54> P 4 11 A 728 AR
HUs Z i a At AT e o R R A A S AR B ST B RIR A S B .

T 1) Xof R R eI B ARE— A n] LA 122 100 9% 3 — A4 17 ) 3o R 09 B Hp s s 25 R
AN o PR A T A T B T 1 48 A B S S A R LR RS s T A B A

MVC B3t e — AT 5 B H — 4 1 Th7 1) 3o 09 it -5 1 4% 1B BT, R VR AE TR
RE AR v 25 B Ml ] 224 4% 100, 9 B e VR A 52 BT B 4% 101 RO A9 18 i, T AN 75 68 A
JO7 (4 A T R AT 4B B

5.2 Spring MVC f§it

Spring MVC J& F Spring Framework [ )5 22/ & . © £l & 7£ Spring Web Flow H,
Spring MVC 738§ 1 # il f BRI G2 43 IR a4 LA KA SRR PP X 2/ 6, XA BT A 5
AT E M

Spring A5 B -0 -4 il #§ (M VOO HE B8 % 0 & Fil € — 1> DispatcherServlet #1111, X
A Servlet 2382k H % 3 i) HT TP 385K 48 A& 45 4 A1 B E SCIF A i b B [ I S ¢
A THC B ) A 3R g e ST OC 2R | TR AL P ) T Y T R A M AR RN B A, D R B X TR
& 3 E Y 5

S FREF PR N Controller, S 78 FF & N H th i T @ Controller Al @ RequestMapping
1) Java ZEMJ5 ¥ . W T Spring MVC 2N Spring i) Web MVC I & 4 £ N & 7£ Spring
H . BT A Spring 4 Spring MVC IR B85 J7 3548 16 T L 24 RAE I ECE . Spring 3.0 DA
JE #2447 @Controller FEfEHLE . @PathVariable ¥ f# , UL J — 26 H Al ag 55, 15 JF & 5
R RT3 [ E] DU Spring MVC #£4F RESTful Web 3 £ 08 A9 HF % .

1E Spring Web MVC 1, 0] Ul AR Al Java XF G2 4E Jy $0AT 15 3R Ab 38 A9 4 2 X 4 sl 6
BARSCYE A B A 3R (71 6F R T T 20 S I HE ZR AR DG Y 1 8RR 2R . Spring B8R 98 5 JE R R
e B, B o B ARG SRR DL IE 5 ] i B A AT A B Iz AT I IR A R T AR AR S8 A
B ZHIVRFTREZ 1 kS v 10 S8 B e e, 1 R R X G b A T A R A i BdE L (B JE 2R
R A HR TR R M 55 A 1 L OE B S, I HLE T B AT A 4 R 1 A8 55 X 4 26
A, AT Spring RS IEALH] , PR AR DX AT R 55 X R0 E B R IPRT L L E R
ol s prik = N

Spring WAL BT BT A 5 i ROG . A — A ST UE RS — > Map BEAY I 784K
P IR A1 —A~ G A 18] 45 55 R) IR A AT LA R B S B e R g, AL I iR AT
JERWE, AP 2P E AL S S SO R 2 Accept WA Sk Bean it B SC/F 45 A IC B
ZRATLL A O S — AW B E BT 25 ViewResolver, #5171 (Model) H 52 J& — 4~ Map 25 5 (1)
Fe 1 WIS b A R s L BT B R h i o 8 1 ok, AT DL TR AR Y TR e BOR B R
4, JSP ., Velocity fil Freemarker 45 . 7] DL B #4: i XML, JSON, Atom DL} H:Ath £ Ff
KRN A . Map B RL 2 5] 58 4 % 45 75 i B 4% 20, 0 JSP /9 3 5K & 1 Cattribute) , —
™ Velocity # AR AT EE
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5.3 MVC 4l Fnimi f

Spring MVC R R 4552 T Model-View-Controller 35 1148 28 AU AE 2, B 65 X S48 &
WS 3 Web R FH AR 7 0 4000 FAE 2 v
Spring MVC X+ URL i K (4 b BEHE 2 4N [&] 5-2 firm

Web.xml
dispatcherServlet

r————-1 HandlerMapping

2. FEHURLE RS

1. URLi% K R .
ARG KL PR %
WIVLEF DispatcherServlet 7 @Controller
-————————— B Java Class

|

|

s s ||
7. KRR 6 MFMELT | AR

|

|

4. I F Service
NE25E

|
&% View !
|

Model H= ViewResolver ModelAndView

@Service
Java Class

8. HUTMIEE
DU HTTPIAR 4 | JSP/PDF/JSON..
5 SIAEIOFIE]

gHR

5-2 Spring MVC 894k & #f &

R ey E A4S T Spring MVC H A% DI RELH1F Y 2 X,

(1) DispatcherServlet: Spring MVC &1 1% 51 o #25 #ll 2% . Ir A 09 35 K AR 4 k& 1R 51
VAR A BT 58— 34 2R 53 S AR 1 4R BRI login, action X AE B URL 385K 5 B, 1 5E %
DispatcherServlet IR H3E K , 2R 5 MG L {5 B £ HandlerMapping # &F $k AL ¥i% URL 1
LKW Java JEFURH R () &b 38 572

(2) HandlerMapping: £ /£ T URL 5 Controller Java Z& Ml J5 ¥ ) bt 5 ¢ &,
DispatcherServlet 75 2t Bz % 4 8 7 HAK Y Java XF LMk, BB URL 352K .

(3) Controller: #itric MZE A Controller ST it N E X Java F ik, AFH A K
A FE URL &K 0 H P b #1515 K, I SEBE Controller $2 FES , 20 (R I £E F2 % 4 9F A
A EE M. Controller ZEK I8 XTI URL 9 Java J5 ¥ A0 3 Pl R, IF B & N B e e J2
4 f# FHl ModelAndView, — H. Controller H1 ¥ Java J7 ik Ab ¥ 52 P i =K U B JF A& A\ 53 Bk
E#AHERA & Bl ModelAndView X445 DispatcherServlet Bif o 45 il £

(4) ModelAndView: £ T H# (ModeD FIARL & (View) , LR 4h 3] 2 )5 75 2R
BE AL R View Hrpg %, i 5 B B SH B 5. View 757 R 8l 5 80 19 4% Fh ot
T A, W JSPLPDF XML, JSON #% X (JavaScript H1 B8 X 50 4%
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(5) ViewResolver: Spring & fit i) ¥ [ fi# A1 4% (ViewResolver) 7 Web i JH H # 4%
View CEUHE 7R A0 D XF G, DT AH I 55 780 v (i 504 5 00 T e A7 T g R B A 38D B 5
TE G4 i 435 SR 3R [0 45 75 7 v

MNHE R 11 3% 4K 3 U6, DispatcherServlet 244~ Web i 1942 i 8% , 75 224 web. xml
FECE ;s Controller /&£ X HARK A URL 54 Hetp 15 R AL B & b (i =l 2%, B 2
H & 5B E R Java 2551 Model AndView 247 T AP Hreep 353K 4 R B9 75 2R [ &
Ui 1) B A5 A R (ModeD) FITE 2 7 i i 2 Jie BLAICHE 77 X AL 1B (View) R 43 I 45

XX LA Spring MVC HEZE P AR B L &, FH T4 3k B % 7 o (9 3 oK, H 2 T4
b (I

@ % P umig R #2282 3| DispatcherServlet,

@ th DispatcherServlet 5 i #5% £ #] — > 3% £ 4~ HandlerMapping . 3% | 2k 3 3% >R 1)
Controller,

@® DispatcherServlet ¥R #2232 3| Controller,

@ Controller W HMk 55 #Z A #EJ5 L3R [1] Model AndView

® DispatcherServlet 5 if] — £ 4~ ViewResoler 1 F % #7 %% » % 3] ModelAndView
5 AL

© L I1E] 1757 K 45 2R s B %7 3

JofF —AH MyEclipse JF % ¥ Spring MVC Web i i helloworld Sl , 4% T kK #: 41
YRR A G BIE N .

(1) BE—4 Web I H , 3 H 4 # K Spring MVC_HelloWorld_demo.

E$E File>New—>Web Project %, W& 5-3 fF/N.

B Workspace - Javs Enterprise - MyEclipie Entérprise Warkbench
File Edit Mavigate Search Project Run Window Help
Mew Alt+shift«N* 55 EJB Project R T =
Open File... L5 Enterprise Application Project
3 Open Projects from File System.. a1 Web
Close cuiewy B Application Client Project
Close All Ctril+Shift+w B Connector Project
Save Cul+s 3 Web Service Project
= 22 Java Project
;::: :f. i Cirl+Shiftes @ Web Fragment Project
e 5 Report Web Project
Move... Ateshifesy | Froject..
! Rename... Fz B Package
& Refresh ps & Class
Convert Line Delimiters To > ‘J; ::_T:d"
Print... Ctrl+P W Applet
Switch Warkspace * (W HTML (Advanced Templates)
Launch New Workspace * [4f ISP (Advanced Templates)
Restart W XHTML (Advanced Templates)
K Iport. & Servlet
s Export.. (@ EIB3 Session Bean
Maven * [ EJB3 Entity Bean
Propartias Alt+Enter & EIB3 Message Driven Boan
1 HelloController java [Springhve_Hel...] (& XML (Advanced Templates)
2 webxml [SpringMVC_Hello_demay..] 9 Example...
3 applicationContesxt.sml [SpringhMVC_L.] 9 Other... Ctrd+N
4 springmve-serviatxml [Springhve_la.] [ [
Exit
¥ P iest
< x

5-3 #E Web Project

1E Project name F1 4544 N Spring MVC_HelloWorld _demo, I& 5-4 /s,
My Next ##l, R FFBINBC B, 2 J5 FF 9 i Next # . 2 % Generate web. xml
deployment descriptor, 41 5-5 i,
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[ Mew Web Project o x
Create a JavaEE Web Project
Specify project name and other details
Project name: :Sprinngt_HeIIuWorId_demd
Project location
[4 Use default location
eation: D\Workspace\SpringMVC_HelloWorld demo Browse...
Project configuration
Java EE version: JavaEE 7 - Web 3.1 v
Java version: 11 v
J5TL Version: 122 %7
[ Add Maven support Leam more about Maven in MyEclipse (mZe)..
Target runtime
MyEclipse Generic Runtime for JavakE 7.0 ~  Add New Runtime...
EAR membership
[ Add project to an EAR
EAR project name: EAR New Project...
Working sets
[JAdd project to working sets New...
Working sets: Select...
® < Back Next = Finish | Cancel

5-4 45 % Web Project

B3 rew web Project

Web Module

lb.

Configure web module settings.

Context root: SpringMVC_HellowWaorld _demo
Content directory: WebRoot

[=] Generate index jsp welcome file
Generate web.xml deployment descriptor

® < Back Mext = Cancel

B 5-5 4% Generate web.xml deployment descriptor

e Jei ¥k Finish 4241,

(2) #In Spring MVC AH5€ jar 14, £ Spring MVC_HelloWorld_demo it H , M\ 5t
H A £ SE B % 8 Configure Facets...—>Install Spring Facet, i1& 5-6 s,

Z e MK 5-7,

PREFBON I E , i Next #241, A 5-8.

TRFFBRIAE , Bh Next 440, LA 5-9.

AN GX B 75 % Spring 4.1.0 Libraries # A8 Core.Facets fl Spring Web jar 1),
B Finish #%41,
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Wonkspace - Java Enterprise - MyEclipse Enterprise Workbench
File Edit Navigate Search Project Run Window Help

i3~ 08 - H & 2 - i
@ » @ SpringMVC_HelloWorld_demo

Ho Rk S RE RN ARSI T=F Al HIESARE ~TCR AV

MyEclipse Explorer [ Package Explorer ©% = = O
@ type filter text
acesys ~
> % Corelava
> % Hibernate_Rel
» (@ JSPDemo
> £ login_ssh_demo
> (@ login_ssm_demo
> & MyBatis_basic_demo New »
> (& Mybatis CRUD_Annotation ¢ Go Into
> g Mybatis CRUD_demao Show In Alt+Shift+W >
> Mybatis_DynamicSQL_Annot N
s @ M,yahati{gyynam.‘csm_'dem % Openin Eray
3 (= Mybatis_MoreQueries_demo @ Send to Mail Recipient
> L& Mybatis_Relation_demo Copy Cr+C
U servietDemo B Copy Qualified Name Manage...
» ;‘: :P":"gfgpb:“‘—de’“" [ Paste Ctrl+V' = Install Apache Struts (1.x) Facet
> &5 Sprin _demo Delete Delete
> G5 s:ringmpidemz = Remove from Context Ctrl+Alt+Shift+Down R insralhpache Site g Recet
> §3 springloC_demo SR . @ Install F.?celee Facet
> (@ SpringMVC_Hello_demo R & ? Install Hibernate Facet
> 2 SpringMVC_HelloWorld den : %@ Install ICEfaces Facet
> (@ SpringMVC_i18n_demo iy I ShI @@ Install JavaServer Faces Facet
5 (@ SpringMVC_Interceptor derr  IMPOTt 7 A Install JAX-RPC Facet
; % ::::gmggg-lﬂbtm :":"“h — ” A Install JAX-RS (REST Web Services) Facet
& - 1aghib,_¢ efres| &
> (2 SpringMVC validation demo  cjose Project i ::::::: jxnv:::tce‘
> Prest Close Unrelated Projects 4 Install JPA Facet
< Assign Working Sets... @ Install JSR Portlets Facet
— Run As » mg Install Maven Support - Dependencies Only Facet
Bl image Preview © Debug As » m2 Install Maven Suppaort for Java EE Projects Facet
Profile As > [E Install MyEclipse Report Web Runtime Facet
Restore from Local History... +~ Install Spring Facet
Configure Facets... > I Install TypeScript Facet
JavaScript Modules >
Validation >
4~ Spring Tools >
Java EE Tools >
Team >
Compare With >
Configure >
(= SpringMVC_HelloWorld demo  propeties Alt+Enter
B 5-6 Install Spring Facet 5 & 1

[ Install Spring Facet

Project Configuration

Select the Spring version and runtime

New facet configuration

Spring version: 4.1

Target runtime

MyEclipse Generic Runtime for JavaEE 7.0

< Back

MNext >

7

~ | Add New Runtime...

Cancel

5-7

Install Spring Facet 52 H 2
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[ Install Spring Facet

Add Spring Capabilities

Configure Spring project i

Configure Spring libraries

Type: MyEclipse Library

Libraries will be provided through MyEclipse Library System

Spring Framework version: 4.1.0

Spring Security version:  <none> ~

Spring Webflow version:  <none>
[ Add Spring-Web support (TLDs copied to project, ContextLoaderListener added to web.xml)
E4 Enable AOP Builder

i Larger projects that do not use Spring AOP may see a performance gain by leaving this
disabled.

Specify new or existing Spring bean configuration file?
Bean configuration type: ® New (O Existing

Folder: |src Browse
File:  applicationContext.xml
@ < Back Next > Cancel
5-8 Install Spring Facet & 3
[&3 Install Spring Facet o X

Configure Project Librari

Add libraries to the project. i

~ [E =) Spring 4.1.0 Libraries
> B mp Core
> B =g Facets
» [ = Spring Persistence
» O =g Spring Testing
> [ By Spring Web

Add custom JAR... Remove custom JAR View README...

[J Enable project specific advanced configuration

@ < Back Next > Cancel

5-9 Install Spring Facet A 4

(3) Wi HH %,
Fiihr sre, B A BRBE SE P R % New—>Package, #11E 5-10 fi 7~

v %44 N com.ascent, WA 5-11 ff /N, Z )G By Finish $#4H ,
AT AE XN B AF A Java 05,
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Bl MyEcipse Explorer 0 |l PackageExplorer 25~ 7 0 Fuehuml 1 helloWorid-senvdetoml 17
Q, type filter text 1 «<himl version="1.8" encoding="UTF-8"?>
» (& Mybatis_ dynamicSQL_demo A 25 cbeans wmlns="http://www. springframework.org/schena/beans"
¥ :3 Mybatis MareQueries demo 3 xmlnsxsi="http:/ /. w3, org/ 2001/ XML Schema-instance” xald
» & Mybatis_Relation_demo 4 amlns:context="http: /fww. springframework. org/schema/conte
ﬁ SendetDemo 5 xmlns imve="http:/ . springframework. org/schema/mvc "
Spmg Mybatis demo 6 xsizschemalocation="
¥ ,-Spmgd.GP demo 7 http: /v, springframework. org/schema/beans
b A,SWOP demol B http://wa.springframework. org/schema/beans/ spring-beans- 3
» 1 SpringloC_demo 9 http:/waw, springframework,org/schema/context
» (3 SpringVC_Hello_ demo 18 http://www. springframework.org/schema/context/spring-conte
v (3 SpringWVC_HelloWorld_demo 1 http://www. springframenork. org/schema/mve
] QSpnng Beans 12 http://waw.springframework. org/schema/mve/spring-mve-3.8.4
,,,EWHM bis o>
» D  Annotation kn />
v [Bst Cwnfmﬂwd'r HM g
fi Showin Alt+SHIftW? & Enum lcan base-package="com. ascent" />
¥ ‘JF ¥ Open in Explorer @ Interface ingframework. web. serviet.view. Internal
’ lllad Send to Mail Recipient HilPacage M prefix value="/ueb-INF/views/" />
- E opy Cil+C &8 Source Folder suffix” value=".jsp" [»
| =
VBH\@ Copy Qualified Name 1 Angular Project
s B Paste Ctrlsy # s
v X Delete Delete L (Basic Templates
£ Remave from Context Ctrl+Alt+Shift+Down % Fier
Build Path 3 s
Source AsShifs> 9 LStEner
Ref A ShifteT? Serviet s context mve
Rt Dl Console 1
8 image Fi/s Export.. [ Other__ Ctrl+N
Refesh 5 o
Run As H
Debug As )
Profile As )
Restore from Local History._.
Validation H
/7 Spring Took >
UML Took y
Team >
s Compare With )
IZsrc-5pr  prrnein AltsEnter
5-10 #7E Package
[ Mew Java Package ] X
Java Package
Create a new Java package.
Creates folders corresponding to packages.
Source folder: SpringMVC_HelloWorld_ demo/src Browse...
Name: com.ascent| |
[ Create package-info java
@ Cancel

& 5-11 #y & Package

(1) B web.xml, IR AL FNEA .

<servlet>
<servlet-name>helloWorld</servlet—name>
<servlet-class>

org.springframework.web.servlet.DispatcherServlet
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</servlet-class>
<load-on-startup>1</load-on-startup>
</servlet>
<servlet-mapping>
<servlet-name>helloWorld</servlet-name>
<url-pattern>/</url-pattern>

</servlet-mapping>

X ¥ DispatcherServlet fiy 44 4 helloWorld, 3 H il ' 7 Web I B — )5 sh 5t n 2%,
BETRFEA WEBINF H3# T8 —4 helloWorld-servlet. xml ) Spring Bt & 4, It
2R A 44 R 2 7E servlet-name 44 FRJS WA E-servlet. xml,

(5) &N helloWorld-servlet.xml Bt & X, NZAEWNT .

<?xml version="1.0" encoding="UTF-8"2 >

<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:p="http://www.springframework.org/schema/p"
xmlns:context="http://www.springframework.org/schema/context"
xmlns:mvc="http://www.springframework.org/schema/mvc"
xsi:schemalocation="
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans-3.0.xsd
http://www.springframework.org/schema/context
http://www.springframework.org/schema/context/spring-context-3.0.xsd
http://www.springframework.org/schema/mvc

http://www.springframework.org/schema/mvc/spring-mvce-3.0.xsd">

<= = BRI B TE AR A B SR - - >
<mvc:annotation-driven />
<\--AHAshEM -->
<context:component-scan base-package="com.ascent" />
<bean class="org.springframework.web.servlet.view.InternalResourceViewResolver">
<property name="prefix" value="/WEB- INF/views/" />
<property name="suffix" value=".jsp" />
</bean>

< /beans>

WINT mve ZAFZS 0L, TR H T Spring M9 A ZhH$ . IF H3E T B AY  f7 ol 5)
S Fr, Hb base-package="com.ascent" EFHA T Z B 1 package 4 .

B & SCAFE P Y Bean 2RI Spring MVC Hid i B0 —F AL E @ AT 48 . prefix J@ M
AR LI B4 suffix 2 00 PRI S8 30 HLAC B 09 2 jop » AT 76 4 0 85 19 7 15 say Hello O) 1y
IR 9] 1Y) 52 hello, 543X B BC &, X7 1Y 58 2 1 LK 2 / WEB-INF / views/ hello.jsp.

(6) 985 HelloWorldController 3¢,

fidi com.ascent i, 3 H 1 PRAESE B rh e 5 New—>Class, W& 5-12 FIiR .

£ Name 43 A HelloWorldController, ¥4 Finish #% 4, 21 & 5-13 frs .,
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